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Tutorial about how to convert powerpoint to 
dvd 

This tutorial guides you through how to 
convert your PowerPoint presentations to 
play on a home dvd player. 
It's great for: 

� Showing presentations without the need for a computer  

� Distributing your slideshows to friends and colleagues  

� Unattended exhibition presentations, that automatically repeat/rewind  

� Giving your presentations more of a TV feel  

� And generally making you look more professional  

� FREE Downloadable files available at the end of the tutorial 

� This is THE original powerpoint to dvd tutorial - often imitated but never 

bettered  

Theory:

 

You would think that you could just write your 

powerpoint file to a DVD and it would just work. 

We're sorry to report that's not the case. But 

we're pleased to report that it's not that difficult. 

This tutorial will show you how to put your 

powerpoint presentations on to a dvd in 3 easy 

steps. 

Step One - Capture

 

Most powerpoint slideshows have movement and animation. We want to 

preserve this animation on the dvd. For this we used a product called 

Camtasia to grab the slideshow and save it to a video file. You can read more 
about all the software we have used at the end of this tutorial. 

Step Two - Conversion

 

Without getting too technical, your PC runs at a certain resolution (or quality), 

DVD's run at another resolution. Therefore we need to convert the captured 

video file to DVD quality. For this we will use a product called Nero Vision 

Express. We will create a nice DVD menu at the same time. 
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Step Three - Writing the DVD 

We've capture the slideshow, converted it to DVD resolution, created a nice 

DVD menu, now all that is left is to write (burn) the DVD disc. 

Please Note:

 

We do not make, sell or support, the Camtasia or Nero software, we just wrote 

this tutorial to help powerpoint users. 

Optimizing your computer before you start:

 

To get the best results from Camtasia while grabbing your slideshow, keep 

these points in mind: 

� Turn off any software you have running in the background. e.g. Virus 

checkers. Pressing Ctrl-Alt-Del will show you what is running.  

� Run Scandisk and Defrag (Programs > Accessories > System Tools)  

� Turn off something called "graphics hardware acceleration". Click here for 

details  

� Make sure your graphics card "drivers" are the most up-to-date  

� Read the camtasia FAQ pages  

� For specific questions regarding camtasia studio please use the 

companies support forum  

� Do the capturing on your quickest PC  

 

Quick Links: 

Step 1: Capture 

Step 2: Conversion 

Step 3: Writing the DVD 

The software used and tips to get the best results 

Step by Step Powerpoint to DVD Tutorial:

 

Step 1: Capture 

As mentioned in step 2 above, dvd has a resolution of 720x480. So we need 

to capture our slideshow at a similar resolution. In our case 800x600 is a 

close match to capture at, as we cannot set our PC to 720x480. Also 

800x600 will scale down better than 640x480 will scale up.

1 Change the desktop resolution to 800x600 by right clicking a blank area 

of your desktop, choose "Properties". 
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2 Click the "Settings" tab, then move the "Screen Area" slider to 800x600 

pixels. 

3 Change the "Colors" to your highest setting. Ideally set it to (True 

Color) 32bit, 24bit will also work. Click "OK". Then follow your particular 

on-screen instructions to finish changing the desktop resolution 

4 Start Powerpoint. 

 
Open your slideshow. We recommend having a totally blank first and 

last slide, or a slide that follows your template but with no content. 

5 Select the "Insert" menu and choose "New Slide", select the "Blank" 

Layout from the "slide layout" on the right of your screen. 

Then go to your current last slide by holding down the "CTRL" key then 

press "End". 

(c) www.AwesomeBackgrounds.com

 

Then repeat step 5 to add a new last slide. 

6 Go back to your first slide (CTRL-Home), and select the "slideshow" 

menu, and choose "Slide Transition", make sure that "On mouse click" is 

ticked. 

 
This will make the first slide pause before we start capturing our 

slideshow. 

 

Then save your presentation. "File" > "Save"

7 To give your PC less to do while capturing your slideshow save your 

presentation as a "presentation show"... 

 

Select the "File" menu, choose "Save As...." 

 

Change the "Save as type" to "powerpoint show (.pps)". Click "Save" 

 
 

Quit out of powerpoint. 

8 Now we are ready to capture the slide show. Start Camtasia Recorder. 

Check that it is set to record the "screen" by selecting the "Capture" 

menu, choose "Input" and select "Screen". 
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9 This step is optional, but we found it gave much better results with our 

particular presentation. 

In Camtasia Recorder, click "Tools", then "Options", click the "AVI" tab 

along the top. On this page turn off "Auto Configure". Set the 
frames/sec to 10.0 
 

Click "Video Setup". Untick "Key Frame Every 80 frames". Click OK. 

 

Click the "Program" tab, Then tick "Boost priority during capture". Click 

OK.

10 Navigate to your powerpoint show (the .pps file from step 7) using 

windows explorer or "my computer". 

 

Double click your file e.g. mypres.pps 

11 The 1st slide will be displayed until you press a key to move on to the 

next slide. 
Tip: We got better results if we went through the presentation once, before doing the actual 
capture. This allowed the PC to cache the presentation in its memory.

12 When you press F9 Camtasia Recorder will start recording everything 

that happens on the screen. When you are ready, press F9, then press 
the space bar to start your presentation proper.

13 If your presentation is set to wait for a mouse click to move through 

each slide, remember to give the audience time to read each slide, 

before pressing the space bar to move to the next slide. One way of 

doing this is to read the slide out aloud.

14 When you reach your last blank slide, Press F10 to tell Camtasia 
Recorder to stop recording. You will be prompted to save the captured 

slideshow, so choose a directory and enter a filename. 
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Click "Save". Camtasia will save your capture as an .AVI file.

15 That's it for Step One. We told you it was easy!

16 View what we grabbed from powerpoint. How did we do that? We used 

Camtasia Producer to save our captured video file to a flash (swf) file. 

Trust us, when we say this powerpoint to flash is a very powerful 
feature of Camtasia.

Step 2: Conversion 

1 Start Nero Vision Express 2

2 Click "Make DVD" and choose "DVD-Video" 
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3 Click "Make New Movie 

4 Click the "Browse for media" button. Navigate to where you saved the 

original camtasia captured video file. Select the File and click "Open". 

Nero will display an icon to represent your video clip. 

5 Right click the newly added video clip icon and choose "Add to Project" 

6 Nero will add your video to it's storyboard 
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You can add transitions before and after each video clip using nero if 

you want to. We didn't.

7 If you want to add any kind of soundtrack or music to your video clip, 

this is the time to do it. Click the "Show Timeline" button 

 
Then simply browse to your existing audio clip, then drag it from the 

media list to the "timeline" area marked "Audio 1".

8 Click the "Next" button. 

 

If you want to add any more powerpoint slideshows, then repeat steps 3 

through 6. Obviously you will also have to capture each presentation 

using camtasia by following Step 1: Capture. 

9 Click the "More>>" button 

 
Click the "Video Options" button 

10 Change the "Video mode" to NTSC for the United States, or scroll down 

the list to your country for other modes (e.g. Select PAL for the UK). 
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Click the "Next" button.

11 The "Create Menu" page is where you design the 1st screen people will 

see when they view your DVD. 

 
You can add backgrounds, change colors, fonts, etc. It's all fairly self 

explanatory. 

 
For our DVD creation we choose "Layout 2", a still background image, 

and added a title of "Select a video show". 

 

Click Next

12 The "Preview" screen allows you to view and test your dvd. Clicking the 

Menu button on the remote control will always bring you back to this 1st 

screen. 
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Click "Back" if you would like to change how your DVD will look or Click 

"Next" to continue.

13 That's it for the conversion and the DVD menu creation.

Step 3: Writing the DVD 

1 You should now be on the "Burn Options" screen. This screen allows you 

to decide whether to write the data to your cd-writer now, or to a Folder 

on your hard disk for writing to a disk later.

2 Click "Burn To" to choose your CD or DVD writer. Select the device that 

you would like to use. 

3 Double check "Recording Settings" are to your liking. e.g. Turn on the 

"buffer underrun protection".

4 When you are ready. Click the "Burn" button

5 Nero will start the process of converting your original powerpoint 

slideshow video to a DVD compatible format. It will then write the DVD 

disc. It can take quite some time. So go and get yourself a coffee. 
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We used the following software:

 

This is a list of the software we used in putting a powerpoint presentation on to 

a DVD. Although you can use other software for the capturing, conversion and 

writing the dvd. 

� Powerpoint 2002 / XP by Microsoft 

(More details)  

� Camtasia by TechSmith 

(More details - 30 day demo available for download)  

6 If you choose the option to write the data to an "image recorder", then 

nero will ask for a directory and a filename to save the "disc image". 

 
Click "Save". The disc image can be written to a DVD at a later date.

7 Click "Save" if you want to save this dvd project to use again.

8 That's it for writing the dvd. Be sure to read this last section to get the 

best results.

Buy and Download awesome backgrounds for powerpoint 
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� Nero Vision Express 2 by Ahead 

(More details - 30 day demo available for download)  

We particularly wanted to preserve the animations and wipes in powerpoint, 

that's why we opted for Camtasia. If you did not want to preserve the 

animations and wipes, then you could export your powerpoint presentation as 

a series of still images (bitmaps, jpgs, etc), then use Nero Vision Express to 

create a simple slideshow. 

We also looked at a product called TMPGEnc that does do a better job of 

converting the original grab to a dvd format than nero. But to keep this tutorial 

as easy as possible, we decided to use nero's in-built convertor. Also a lot of 

people tend to have nero bundled with there cd or dvd writer. The makers of 

TMPGEnc also make DVD authoring software. 

See smooth animations and powerpoint to dvd from the techsmith site that will 

help you achieve a really smooth capture by utilizing the "time lapse" feature 

of camtasia studio 

See these pages from the techsmith site that will help you with your audio

 

Recording audio - Great sound 

Or add your sound or music using camtasia producer after you have captured 

the video 

If you are a mac user you will probably know that Camtasia does not work on 

Apple Mac's. These two products do screen recording for mac users: 

Screenography and Snapz Pro 

If you're budget is tight, then you may be interested to know that there is a 

free screen capture software called CamStudio. We've not used it so we don't 

know if it's any good. 

Optimizing your presentations for dvd video and TV:

 

The quality (resolution) of a TV is not as good as a computer monitor. Keep 

these points in mind to get the best results. 

� Avoid putting information too close the 

edge of your slides, otherwise this 

information may be cut off when viewed 

on a TV  

� Avoid very small text. A lot depends on the 

quality of the TV and how far back the TV 

will be viewed from. Aim for no smaller 

than 30 point font sizes  

� Avoid very thin lines. Aim for at least 3 

point line sizes  

� Avoid certain colors. Red is notoriously bad for video  

� Avoid very skinny / lite / thin / serif fonts. Aim for Arial (sans-serif), bold 

and black weights  

� Aim for dark backgrounds (dark blue), and light colored text (white / 

yellow)  
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| Home | Products | More Info | Order | Contact | PowerPoint Tips | Site Map | 

 

The software product "awesome" made by the company "By Default" are not affiliated, connected or associated with Microsoft Corporation. 

PowerPoint® are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. 

Send email to presentations@awesomebackgrounds.com with questions or comments about this web site.  

Copyright © 1999-2006 "By Default" All Rights Reserved - Last modified: October 13, 2004 

To download the files used in this tutorial right click 
the image below, then choose "Save target as" (IE), or 
"Save Link As" (Netscape). 

 

� The file contains the actual presentation used in this tutorial. Filesize 

0.25mb  

Have Fun! 

 
Please Note: Although we have made every effort to check the files against viruses at all stages of 

production. It is always wise to run a virus checker on any software before running it. By Default! cannot 

accept responsibility for any loss, disruption or damage to your data or computer system which may occur 

while using either either the CD-Rom or downloaded files. It is assumed that by downloading the files you 

accept these conditions. Otherwise do not use the awesome backgrounds for powerpoint. 

We hope you liked this tutorial. As well as making such great tutorials we also 

design and sell powerpoint backgrounds at 

http://www.awesomebackgrounds.com 

 

You can order and download, within minutes, individual sets of 10 

backgrounds, or if you prefer buy everything we make on 8 CD-ROMs. See the 

new awesome backgrounds for powerpoint  
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